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TI LaunchPad™ Ecosystem: 
Modular and affordable  
microcontroller development  
tools for rapid prototyping 
Electronics rapid prototyping with TI’s broad portfolio of 

MCUs, analog & connectivity solutions 

 

Wi-Fi Internet of Things Workshop 
Texas Instruments 

January 2017 

 



For the greatest crash course on IoT 

and electronics you’ve ever done? 



The Internet of Things 
a history 

Edison & Tesla 
• It pretty much always 

starts with the lightbulb, 

harnessing electricity for 

human applications, took 

lots of famous people to 

get to this point 

The Rise of Electronics 
From large desktop computers to tiny battery powered devices, 

EVERY innovation is all part of the same technology revolution 
 

 

Tubes, Transistors & 

Radio 
• Electric computation and 

communication becomes 

possible and mainstream 

with the creation of the 

basic building blocks 

The Integrated Circuit 
• Jack Kilby, a TI 

engineer, changed the 

world by inventing a 

practical way to shrink 

the size of electronics 

1800s-1900s 1900s-1960s 1958 



The Internet of Things 
a history 

The PC Age 
• Personal computers 

change business and 

productivity in every 

aspect of life worldwide 

The Rise of Electronics 
From large desktop computers to tiny battery powered devices, 

EVERY innovation is all part of the same technology revolution 
 

 

The Internet Age 
• Computers and 

electronics can talk to 

each other creating a 

whole new world of 

applications 

The IoT Age 
• Affordable connectivity 

and processing gives all 

electronics additional 

capabilities for new data 

driven and world 

changing behavior 

1970s-1990s 1990s-2010s 2000s-2030s 



The Internet of Things 
a history 

Government 

This tech wave will have lasting 

effects on EVERY industry 
 

 

Medical 

Agriculture 

Automotive 

Manufacturing 

Transportation Industrial 

Retail / Ecommerce 

Military 

Aviation 

Marine / Aquaculture 

Energy 

Food Real Estate Finance Construction 



 
 
Join the IoT revolution! 
 
See the World! 
 
Build a new industry! 

 Calling all Engineers, Makers, Entrepreneurs 
 

 

 
 

IoT will change your life! 
 

Can you make the next 
Great Product or Service? 

 

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjKsMygh-vOAhUG_WMKHaOMA-YQjRwIBw&url=http://www.prsaneworleans.org/wp/call4volunteers__trashed/uncle-sam-we-want-you/&psig=AFQjCNHVh3tu-LtL-Q8Fs6s-KbLUVxYk0w&ust=1472712326739592


The Internet of Things 
a birds eye view 

Think services 
• Google, Amazon, 

Facebook, etc. 

Think servers 
• Server farms  

& data centers 

IoT Data passes from physical hardware layers to software 

layers back and forth, connecting the real and digital worlds 

Cloud 

Think infrastructure 
• Routers, switches, cell 

towers, fiber optic cable, 

satellite transmitters, 

phone lines 

The 

Internet 

Connected  

Things 

Computers 

Phones 

Think products 
• Anything that can talk to 

the internet or connect 

to something else that 

can talk to the internet 

Edge 

Hardware + 

Software at 

every stage 



TI LaunchPad & IoT   
a bird’s eye view 

MCU +  

Ethernet 

LaunchPad RF 

Booster 

Pack 

MCU + RF  

SoC 

LaunchPad RF 

Booster 

Pack 

IoT Gateways 
Your portal to the cloud 

Ethernet Wi-Fi 

Wireless  

Nodes 
Connecting your 

devices 

MCU 

LaunchPad 

 

 
BoosterPack 

MCU + RF  

SoC  

LaunchPad 

Cloud Service 

Provider 

LaunchPads 

- MSP430  

- MSP432 

- TM4C 

- C2000 

- Hercules 

 

 

RF BoosterPacks 

- Zigbee / Zwave 

- 6LoWPAN / Thread 

- Bluetooth / Wi-Fi 

- SubGHz RF / NFC 

- LTE / Satellite 

MCU + RF SoC LaunchPads 

- CC3200 MCU + WiFi 

- CC2650 MCU + BLE 

- CC1310 MCU + SubGHz RF 

- CC1350 MCU + SubGHz/2.4GHz 

 

Cloud services 

Access to data, 

dashboards, etc 
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Easily add RF for wireless applications! 
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Which wireless? 

• Ubiquitous 

• High bandwidth 

• Higher power 

usage 

• Common 

• Small range 

• Lower power 

• Very low cost 

• Super near 

range 

• Low bandwidth 

• Low power 

• Low cost 

• Mesh networking 

• Low power 

• Very low cost 

• IPV6 Addressable 

• Wide range 

• High bandwidth 

• Expensive 

• Limited to 

certain cities 

• Wider range 

• Low bandwidth 

• Higher cost 

• Mesh networking 

• Low power 

• Very low cost 

• Not IP addressable 

• Line of Sight 

• Low power 

• Very low cost 

Infrared 

Tradeoffs between range, bandwidth, cost, power usage, adoption 

Satellite 

• Global range w/ 

Sat available 

• Expensive 

(LPWAN) 



TI LaunchPad and BeagleBone in the cloud 

Cloud-connected TI Hardware is supported by various cloud 

partners & protocols via Wi-Fi, BLE, LTE, or Ethernet. 



Microprocessors: Microcontrollers vs Single Board Computers 
a comparison 

Design Considerations 
• Do I need an operating system? 

• Do I want it to be low cost? 

• Can I program in C or do I need to 

use another language? 

• Do I need real-time capability? 

 
 

 

 

What’s the difference? 
• TI LaunchPad 

• BeagleBone  

• Arduino 

• RasPi 
 

 



Microprocessors: Microcontrollers vs Single Board Computers 
a comparison 

Advantages 
• Overall less complex 

• Overall less cost 

• Overall lower power consumption 

• Real-time capable 

 

 

 

Disadvantages 
• Less flexible software paths 

• Less performance for computation 

intensive applications 

• Only able to run RTOS but not full 

OS options 

 

 
 

 

 

Advantages 
• Overall higher performance 

• Overall more peripheral 

capabilities 

• More flexible software options and 

the ability to run Linux OS 

 

 

Disadvantages 
• More cost and complexity 

• Managing Linux related updates 

• Real-time capabilities often limited 

• Higher power consumption 

 
 

 

Considerations: 
 Power 
 Integration 
 Performance 



TI LaunchPad™ 

20/40-pin Standardized Pinout 
 Add BoosterPack 
 Jumper to your own hardware 
 BYOB – Build Your Own Boosterpack 

Segmented Display (LCD) 
Avail on some LaunchPads 

User LEDs 

Isolation Jumper 
Let’s you isolate Target 



Microcontroller 

Programming an MCU… 



16 

} { 
Making MADE simple 

With the BeagleBone 

Hardware & Software 
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Why Beaglebone Black is great? 
• Price ~$45 

• Large community 

• Online resources from 

TI and Beagleboard.org 

 

• Full Linux capable single board computer 

• Multiple supported SW paths 

• Completely open source for building your 

own derivative products! 

With BeagleBone Black and Capes 

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwjFreTboNjRAhXHNiYKHfroAvgQjRwIBw&url=http://rlx.sk/en/175-beagleboard-beaglebone&bvm=bv.144686652,d.eWE&psig=AFQjCNG1nCeCUXjAZXsO48ajzi3EThK8VQ&ust=1485260509732970
http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwiNo-KWodjRAhVJOSYKHapYCoUQjRwIBw&url=http://beagleboard.org/Green&bvm=bv.144686652,d.eWE&psig=AFQjCNGGQhfW9Xcb_rjGcqHrnEHQMB_I5Q&ust=1485260611574554


BeagleBone Black 

BeagleBone Black 

Processor: AM335x 1GHz ARM® Cortex-A8 
• 512MB DDR3 RAM 
• 4GB 8-bit eMMC on-board flash storage 
• 3D graphics accelerator 
• NEON floating-point accelerator 
• 2x PRU 32-bit microcontrollers 

 
Connectivity 
• USB client for power & communications 
• USB host 
• Ethernet 
• HDMI 
• 2x 46 pin headers … Add a ‘Cape’ 

 
Software Compatibility 
• Debian 
• Android 
• Ubuntu 
• Cloud9 IDE on Node.js w/ BoneScript lib 
• plus much more 

http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358
http://www.ti.com/product/am3358


AM3358 Microprocessor 



Performance vs Power 



MSP430 is leading ultra-low power processor 

MSP430 

microcontroller 

running off three 

grapes. 

 

It ran for almost two 

weeks before the 

grapes dried out too 

much. 

 

Is this how raisins are 

made? 



TI’s Embedded Processor Portfolio Microcontrollers (MCU) Application (MPU) 

MSP C2000 Tiva C SimpleLink Sitara DSP Keystone 

16-bit/32-bit 32-bit 32-bit 32-bit 32-bit 16/32-bit 32-bit 

Ultra Low Power & 
Cost 

Real-time Connectivity Wireless 
Linux 

Android 
All-around  

DSP 
Massive 

Performance 

• MSP430  
16-bit RISC 

• MSP432 
32-bit ARM 

• Real-time C28x 
MCU 

• ARM M3+C28 

ARM 

Cortex-M4F 

ARM 

Cortex-M3  

Cortex-M4 

ARM 

Cortex-A8 

Cortex-A9 

Cortex-15 

DSP 

C5000 
C6000 

• C66 + C66 

• A15 + C66 

• A8 + C64 

• ARM9 + C674 

• Low Pwr Mode 
 250nA (RTC) 
 770nA (LCD) 

• Smart Analog 

• EnergyTrace++ 

• Motor Control 

• Digital Power 

• Precision 
Timers/PWM 

• 32-bit Float 

• Massive I/O 

• Ethernet 
(MAC+PHY) 

• M4 w/ WiFi 

• M3 w/ 2.4GHz 

• M3 w/ Sub-1GHz 

• $5 Linux CPU 

• 3D Graphics 

• PRU 

• Industrial I/O 

• C5000 Low Power 
DSP 

• 32-bit fix/float 
C6000 DSP 

• Fix or Float 

• Up to 12 cores 4 
A15 + 8 C66x 

• DSP MMAC’s: 
352,000 

Flash: 512K 

FRAM: 128K 

512K 

Flash 

1MB 

Flash 

256K to 3M 

Flash 

L1: 32K x 2 

L2: 256K  

L1: 32K x 2 

L2: 256K 

L1: 32K x 2 

L2: 1M + 4M 

48 MHz 300 MHz 120 MHz 220 MHz 1.35 GHz 800 MHz 1.4 GHz 

Rapid Prototype with  
TI LaunchPad Ecosystem 

Get Started with 
BeagleBoards 



TI LaunchPad & BeagleBone Embedded System Design 
a bird’s eye view 

MCU 

LaunchPad 

or MPU  

BeagleBone 

Sensor 

Embedded System 
• Power Management 

• Communication 

• Processing 

• Analog 

Design Accessories 
• Plug-in modules 

• Through hole (breadboard) 

circuits 

• Oscilloscope & logic 

analyzer & multimeter 

• EDA / CAD tool (PCB and 

enclosure design) 

• IDEs and SW Dev tools 

Cloud 

RF Radio 

/ Wired 

Comm 

Power 

Motor 

Control 

Input /  

Output 

Display 



Quick demo recipes 
Enable customers to experience TI differentiation 

WiFi 

CC3100 

BoosterPack 

Thermocouple 

BoosterPack 

(ADS1118) 

WiFi-enabled Meat Probe 

“iGrill”. Send a tweet when 

temp exceeds threshold. 

MSP430F5529 

LaunchPad 

= + + 

NFC/RFID 

(TRF7970A) 

LiPo Battery 

BoosterPack 

(BQ fuel gauge) Create a battery-powered 

WiFi-connected NFC/RFID 

tag reader 

CC3200 Wi-Fi 

LaunchPad 

= + + 

Sub-1GHz 

(CC110L) 

MEMS Temp Sense 

BoosterPack 

(TMP006) Create a multi-point SubGHz 

RF wireless temperature 

sensor network 

MSP430G2553 

LaunchPad 

= + + 

TI Microcontroller TI Wireless TI Analog 



Does it feel responsive? 
Does it feel like magic? 

Active Control 

 Human physically interacts 
with machine or system 
 Buttons 
 Touch screen 
 Wired or wireless 

Controller 
 Has to be responsive 

 Quick reactions to input 
 Graphical indicators 
 Light, sound, or haptic 

indicators 

Passive Control 

 Machine or system automatically 
performs tasks 
 Requires minimal Human input 
 Leverages real world sensors or 

incoming data to make 
decisions 

 Leads to poor user experience if 
interaction model is broken 
 E.g. Automatic door  

doesn’t open 

Human Machine Interaction 

Which philosophy is  
Amazon Echo? Xbox? 
Nest Thermostat? 



Product Development 
a birds eye view 

Hardware is hard, so you need to have a plan and understand 

the product development cycle 

Concept 

Research 

Evaluation 

Summary from Maker.io 

Design 

Prototyping 

Funding 

Marketing 

Production 

Distribution 

Support 



What does TI do? 

 

 

We connect electronics customers to 

devices and technology that will help 

them build amazing products! 

 

 

What we’ve done  

for over 85 years… 
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Digital video 
recorder/server 

Digital 
still cameras 

IP 
phones 

 
Wireless 

infrastructure 
 

Smart phones 

Motor control 

Computing 

Digital TV 

eBike 

Digital audio & radio 

Wireless LANs 

Smart energy 
meters 

Industrial weigh 

scales 

Medical 
Test equipment 

Automotive 

& HEV 

Analog and 

Embedded Processing 

Everyday electronics that use TI technology 

 

 

TI builds technology that connects the signal 

chain from the real world to the digital realm 



university.ti.com 
The Texas Instruments 
University Program is dedicated 
to supporting engineering 
educators, researchers and 
students worldwide.  

 



Want to work for TI? 

31 

• Internships 

• Rotation Programs 

• Full-time positions 

www.ti.com/careers 



Workshop Materials 

• MSP432 LaunchPad (MSP-EXP432P401R) 

– Alternative: MSP-EXP430FR5994, MSP-EXP430F5529LP, EK-TM4C123GXL 

• CC3100 Wi-Fi BoosterPack (CC3100BOOST, CC3100MODBOOST) 

• Educational BoosterPack MK II (BOOSTXL-EDUMKII) 

37 



MSP432 LaunchPad 
Introducing the MSP432 processor for Low Power + Performance 

Target MCU: MSP432P401R 

BoosterPack Pinout: 40-pin 

Specs: 

• 48 MHz 32-bit ARM® Cortex™-M4F CPU 

• 256 kB Flash / 64 kB RAM  

• 14-bit 1MSPS SAR ADC, Timers,  

AES Accelerator, I2C, UART, SPI 

 

EnergyTrace+ to measure system current 

Good performance balance & great for 

general purpose applications 

Why this LaunchPad? 

$12.99 

MSP-EXP432P401R 



Pre-work 
We will break here and get started with the hardware! 

1. Download Energia from www.energia.nu 

2. Unzip Energia to “install” it 

3. Start Energia and select your LaunchPad “LaunchPad w/ msp432 EMT (48MHz)” 

from Tools menu. 

 

 

4. If LaunchPad isn’t available, then go to the board manager  

to install – Tools > Board > Board Manager…  

5. Create your free accounts at: my.ti.com and temboo.com 

Lab: https://goo.gl/VbymuW 

http://www.energia.nu/
my.ti.com
temboo.com


Lab 1 CCS Cloud & MSP432 LaunchPad Out of Box 

1. Open TI Resource Explorer Cloud from dev.ti.com 

2. Find the Out-of-Box Experience (OOBE) for MSP-EXP432P401R – Rev 2.x (Red) 

3. Import OOBE into CCS Cloud 

( You will need to log into  

  my.ti.com to access the IDE ) 

 

 

4. Build the OOBE project (using hammer icon) 

and then click on “Run” to download the program to the LaunchPad (see LED blink) 

5. Click back over to the TI Resource Explorer window and select: 

  Out-of-Box Experience GUI 

6. Connect the GUI to the LaunchPad (“Connect” button) 
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Lab: https://goo.gl/VbymuW 
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} { 
Making MADE simple 

With the TI LaunchPad  

Hardware & Software 
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Rapidly Prototype  

TI Solutions with  

Modular Hardware, 

Intuitive Software,  

& Community Support 

The LaunchPad Concept 



This overview shows why TI LaunchPad™ is the highest 
value microcontroller development tool on the market 

Modular & Affordable 

Hardware 

Intuitive & Flexible 

Software 

Accessible & Engaged 

Community Support 
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Why TI LaunchPad™ is better? 

• Price ($10-$30) 

• HW Debugger 

• TI online resources 

 

• Focus on Prototype to Production 

• Performance and Variety 

• Multiple supported SW paths 
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LaunchPad is TI’s Common Denominator 

47 

TI Wireless: Sub-1GHz, NFC/RFID, Wi-Fi, ZigBee, BLE, Bluetooth 

Analog, sensors, displays & more from TI, 3rd parties & Maker 

community 

Modular hardware enables developers to explore new ideas quickly 

MSP430 
(Ultra-Low Power) 

TM4C 
(ARM Cortex M4F) 

C2000 
(Real-time Control) 

 

Hercules 
(Safety) 

LaunchPads featuring TI MCUs & BoosterPack interface 

CC3200  
(MCU + WiFi) 
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BoosterPack pinout standard (ti.com/byob) 

http://www.ti.com/ww/en/launchpad/dl/boosterpack-pinout-v3.pdf
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BoosterPack pinout standard (ti.com/byob) 

50 50 

The BoosterPack pinout standard enables: 
- Cross-compatibility between LaunchPads & 

BoosterPacks 

- BoosterPack stackability to create more complex 

solutions 

- The same BoosterPack can work across multiple 

LaunchPads 

 

- Learn more @ www.ti.com/byob  

- Build your own BoosterPack (BYOB) with 

templates, resources & more! 

http://www.ti.com/ww/en/launchpad/dl/boosterpack-pinout-v3.pdf
http://www.ti.com/byob
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The LaunchPad Ecosystem 
Everything you need to start microcontroller development 

Hardware + Software + Community 

Over 20 types of LaunchPads for 

different application needs! 



The LaunchPad Ecosystem 

Full specs at www.ti.com/launchpad 

General & 

Special 

Purpose 

MCUs  
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The FRAM Advantage: At a Glance 

  Write More 
Collect more data over time with 100x faster writes than Flash  

Extend product life and ditch the EEPROM with infinite endurance  

Decrease Power 
Extend battery life with 250x lower energy writes vs Flash 

Minimize wireless system power by shortening memory update times 

 

Unified Memory 
Simple to use with unmatched flexibility 

Migration guides, code examples and application notes available! 

www.ti.com/fram 
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The LaunchPad Ecosystem 
Everything you need to start microcontroller development 

Hardware + Software + Community 

Many orderable BoosterPacks and 

open source designs available! 
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Educational BoosterPack Mk II 

• Manufacturer: Texas Instruments 

• Part #: BOOSTXL-EDUMKII 

• MSRP: $29.99 

• Feature List: 

– 128x128 pixel color TFT display  

– 3 axis accelerometer, 2-axis joystick 

– TI TMP006 temp sensor 

– TI OPT3001 Light Sensor  

– Microphone, Buzzer, RGB LED 

– Servo connector, Push buttons 

 

• Learn more @ www.ti.com/boosterpacks  

Create new projects with this useful add on! 

http://www.ti.com/boosterpacks
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CC3100 SimpleLink Wi-Fi BoosterPack 

LaunchPad in the cloud 

• Manufacturer: Texas Instruments 

• Part #: CC3100BOOST 

• MSRP: $19.99 

• Feature List: 

– CC3100 WiFi Transceiver 

• IEEE 802.11 b/g/n 

• Embedded IPv4 TCP/IP stack 

– Small form factor 

– Complete software solutions & features 

TI’s unique SimpleLink technology 

• Learn more @ www.ti.com/boosterpacks  

http://www.ti.com/boosterpacks
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Sharp ® Memory LCD BoosterPack 

• Manufacturer: Texas Instruments 

• Part #: 430BOOST-SHARP96 

• MSRP: $19.99 

• Feature List: 

– Sharp LS013B4DN04 Memory LCD 

• 1.3" inch screen offering 96 x 96 pixels 

• Ultra-Low-Power consumption 

• Display controlled serially using SPI 

– Software enabled by TI’s software libraries 

• Graphics Library Support 

• Capacitive Touch Library Support 

• Learn more @ www.ti.com/boosterpacks  

 

 

Add capacitive touch and display capabilities with 1 board! 

http://www.ti.com/boosterpacks
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Kentec QVGA TFT LCD BoosterPack 

• Manufacturer: Texas Instruments 

• Part #: BOOSTXL-K350QVG-S1 

• MSRP: $24.99 

• Feature List: 

– Kentec TFT LCD (P/N: K350QVG-V2-F)  

– 3.5 inch QVGA (320x240 resolution)  

– SPI Interface 

– 4-wire resistive touch screen 

– White LED Backlight + driver circuit 

– Complies with the BoosterPack standard 

for use with 20 and 40 pin LaunchPads 

• Learn more @ www.ti.com/boosterpacks  

 

 

Add resistive touch and display capabilities with 1 board! 

http://www.ti.com/boosterpacks
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Infrared (IR) BoosterPack Plug-in Module 
Start developing remote control applications today! 

• Manufacturer: TI 

• Part #: Boost-IR 

• MSRP: $20 

• Feature List: 

– IR LED transmitter 

– IR receiver + demodulator 

– 4x4 membrane keypad 

– 20-pin BoosterPack standard for use with any 

LaunchPad 

– Compatibility with different IR signal 

generation methods 

• Learn more @ www.ti.com/boosterpacks  

 

http://www.ti.com/boosterpacks
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CC110L Sub-1GHz RF BoosterPack (433, 868, 915MHz) 
Start developing wireless applications immediately! 

• Manufacturer: Anaren / TI 

• Part #: 430BOOST-CC110L 

• MSRP: $19.99 (includes 2 RF BoosterPacks!) 

• Feature List: 

– Based on TI CC110L SubGHz RF transceiver 

– SPI interface between RF module & MCU 

– FCC/IC certified module 

– Includes AIR BoosterPack Stack software 

– Enabling Star network & p2p topologies 

– Includes pre-programmed MSP devices 

• Learn more @ www.ti.com/boosterpacks  

http://www.ti.com/boosterpacks
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TRF7970A NFC BoosterPack 
Start developing with Near-Field Communication & RFID! 

• Manufacturer: DLP Design 

• Part #: DLP-7970ABP 

• MSRP: $25 

• Feature List: 

– 13.56MHz HF RFID Reader/Writer 

– Supported by the NFCLink software library 

– Supports various modes: 

– RFID/NFC Reader 

– NFC Peer 

– Card-Emulation Mode 

– FCC/IC approved design 

• Learn more @ www.ti.com/boosterpacks  

 

 

http://www.ti.com/boosterpacks
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Companion Kits: Seeedstudio 
Must have LaunchPad accessories! 

• Sidekick Basic Kit for TI LaunchPad™ 

• MSRP: $29.99 

• Feature List: 

– 100+ commonly used breadboard components 

– 10+ example circuits and code 

• Learn more @ www.energia.nu/sidekick 

• Grove Starter Kit for TI LaunchPad™ 

• MSRP: $59.00 

• Feature List: 

– 10 sensor modules with example code 

• Learn more @ www.energia.nu/grovekit  

 

http://www.energia.nu/sidekick
http://www.energia.nu/grovekit
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Sidekick Basic Kit for TI LaunchPad™ 
Part List 

1x Breadboard 

1x Breadboard Adapter BoosterPack 

5x Green LED 

5x Red LED 

1x RGB Common Anode LED 

10x Ceramic Capacitor 10nF 

10x Ceramic Capacitor 100nF 

5x Aluminum Capacitor 100uF 

10x Resistor 330 ohm 

10x Resistor 1K ohm 

10x Resistor 10K ohm 

1x Tilt Switch 

1x Thermistor 

1x Photoresistor (photocell) 

1x Diode 

1x Piezo Buzzer 

 

 Learning Over 100+ electronic components to build basic and complex circuits 
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

5x Button 

5x Switch 

2x Potentiometer with knob 

1x Small DC Motor 

1x 7 Segment Single Digit Display 

1x 8-bit Shift Register (SN74HC595N) 

2x NPN Transistor (2N2222) 

1x Analog Temperature Sensor 

(LM19CIZ/NOPB) 

5x Jumper Wire Long 

20x Jumper Wire Short 

1x Sidekick Manual 

 

Manufactured by Seeedstudio 
 

Learn more @ www.energia.nu/sidekick   

http://www.energia.nu/sidekick
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Grove Starter Kit for TI LaunchPad™ 
Part List 

1x Grove Base BoosterPack 

1x Grove Buzzer (Digital) 

1x Grove Relay (Digital) 

1x Grove 4-Digit-Display (Digital) 

1x Grove Ultrasonic Range Sensor (Digital) 

1x Grove PIR Motion Sensor (Digital) 

1x Grove Light Sensor (Analog) 

1x Grove Sound Sensor (Analog) 

1x Grove Moisture Sensor (Analog) 

1x Grove Temperature Humidity Sensor (Analog) 

1x Grove Rotary Angle Sensor (Analog) 

Grove Cables 

Starter Guide Manual 

 

 

Learning 10 different grove modules to build basic and complex systems  
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

Manufactured by Seeedstudio 
 

Learn more @ www.energia.nu/grovekit  

http://www.energia.nu/grovekit
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Click BoosterPack 2 

Click BoosterPack 2 has two mikroBUS sockets 
onboard, for simple and easy integration of 
MikroElektronika click boards with a TI LaunchPad™. 
 
Add new functionality to your LaunchPad within 
minutes. More than 250 click boards available from 
audio and voice to power management and wireless 
connectivity clicks. 
 
All MikroElektronika compilers come with code 
examples, so you’ll have a great base to start with. 
 

 

 

Learning Click boards to build basic and complex systems  
Compatibility Useful with any TI LaunchPad or other digital / analog development kit 
Completeness All the popular accessories for beginners to develop with microcontrollers 

Manufactured by MikroElektronika 
 

Learn more @ www.energia.nu/click  

https://shop.mikroe.com/click
http://www.energia.nu/grovekit
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Breakthrough Sensor Technology www.ti.com/sensing 



www.ti.com/tidesigns 



96 For FREE! 

CODE! 



LaunchPad Software Tools - providing multiple points of entry 

Energia 
Light-weight, Community-driven, 

Wiring-based IDE for quick evaluation 

• Intuitive coding environment 

• Simplified interface 

• Highly-abstracted API framework 

• Open Source & Community-driven 

CCS & Pro Tools 
Fully-capable dev environments 

from TI & third parties 

• Full debug capability & more 

• Import Energia projects 

• Access to third party 

compilers,  features, and apps 

Rapid Prototyping Advanced 

CCS Cloud  
Browser-based code editor and 

Resource Explorer 

• Cross Platform 

• Fast start & no installation 

• Use Energia, TI-RTOS & more 

• Resource Explorer integration 

Evaluation 

Intuitive & flexible software development paths speed up 
firmware creation for rapid prototyping 



Energia Abstraction 
Fly high above the bits & bytes 

99 

Boils it down to      line of code 1 { } 
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Energia Import in CCSv6+ and CCS Cloud 
• Import an Energia sketch into Code Composer Studio v6 & pick up right where you left off. 

• CCS introduces full debug capability & other professional features to further optimize your design. 

• Modularize your code & leverage Energia APIs & libraries within CCS 

• Enable “hybrid” projects that leverage low-level C, assembly & even abstracted Energia APIs 

enabling a developer maximum flexibility during code development. 
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Code Composer Studio Cloud 

• Browser based code editing tool  

to get your started quickly 

• Access Resource Explorer to get  

the latest code examples, design  

files, and more. 

• Cross Platform and allows you  

to upload firmware using TI  

Cloud Agent + Browser Extension 

• Extended Debugging capability 

http://dev.ti.com  
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Code Composer Studio 7 
• Eclipse-based IDE for professional 

firmware developers that supports  

all TI processors 

• CCS App Center allows you to stay 

current with the latest plugins and 

updates 

• Use tools such as Energy Trace, 

GRACE, and more to optimize your 

workflow and application 

• Resource Explorer exposes thousands 

of code examples  

and technical materials 

 

Download CCS Desktop at ti.com/ccstudio 



• Many free and open source options 

available today with TI RTOS and 

FreeRTOS recommended for TI devices 
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TI-RTOS and FreeRTOS 
• The use of Real-Time Operating 

Systems (RTOS) is getting more 

common for IoT firmware deployment 

• A simple operating system can 

schedule tasks and do a variety of 

functions  

• RTOS helps with maximizing power 

efficiency, implementing security, 

managing wireless communication, 

and other complex functions  

• Improves software quality and 

portability 

 

Download TI-RTOS at ti.com/tool/ti-rtos 



MSP Software Development 
Pick a Coding Style…             Choose a Tool… 

Energia IDE 

CCS Desktop 

CCS Cloud 

/ RTOS 



www.43oh.com  e2e.ti.com  

Accessible & engaged community support gives new and 
experienced developers information to solve issues quickly 

www.hackster.io/ti-launchpad  ti.com/lyd 

http://www.43oh.com/
http://e2e.ti.com/
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.ti.com/lyd
http://www.ti.com/lyd


• www.43oh.com 

• ~20,000 active members 

• ~60 forum users online at any given time! 

• Active & friendly online community & blog for the 

LaunchPad ecosystem! 

• Home to much of the Energia community 

The Community 
Get support from TI & the online community! 

• http://e2e.ti.com   

• Supported 24/7 by TI engineers! 

• Over 1 million Q&As available on-demand 

• Get support on TI’s complete portfolio from 

microcontrollers to analog to connectivity 

http://www.43oh.com/
http://e2e.ti.com/


                             - Share your electronics projects! 

www.hackster.io/ti-launchpad 

www.hackster.io/texasinstruments  
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http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/ti-launchpad
http://www.hackster.io/texasinstruments
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Where to go next: www.ti.com/launchpad 
TI’s official LaunchPad portal 

Get specs, order hardware, find software tools, and 
download datasheets and design files 

Sign up for a 

myTI account! 

http://www.ti.com/launchpad


} { 
Making MADE simple 

With the TI LaunchPad  

TI LaunchPad™ provides an ecosystem of hardware and 
software products, and community online resources that 
provides incredible value for rapid prototyping 

Questions? 

www.ti.com/launchpad 



Lab 2 Energia Introduction with Blink and the EduBP 

We will break here and get started with the hardware! 

• Step 1: Install Energia IDE from www.energia.nu 

– Alternative use the CCS Cloud IDE from dev.ti.com 

• Step 2: Install any OS specific drivers associated with your TI LaunchPad 

• Step 3: Plug in your TI LaunchPad board with the included USB cable 

• Step 4: Open Energia IDE and adjust your preferences as necessary 

• Step 5: Open basic test example - click File > Examples > Basics > Blink 

• Step 6: Select your LaunchPad board or install board package – click Tools > 

Board 

– If LaunchPad is not MSP430 then go to the board manager to install – Tools > 

Board > Board Manager… and install your package from the menu. Select your 

specific LaunchPad from the list after installation.  113 

Lab: https://goo.gl/VbymuW 

 

http://www.energia.nu/


• Step 7: Click the upload button and make sure your Red LED is blinking 

– If not or you get errors during compile, your system is not properly setup and 

you will not be able to proceed, so seek assistance from instructor or neighbors 

– If yes, then you can now test the Educational BoosterPack 

• Step 8: Open EDUBP example mentioned in the lab details 

• Step 9: Click the upload button. You can use the joystick and see results on the 

LCD. Test it out! 

• Step 10: There are additional examples for the BoosterPack that you can try if you 

have extra time, however we will be moving on quickly. They are documented at 

www.energia.nu/edumkii 

• Examples are located in the IDE, click File > Examples > EducationalBP_MKII  

 114 

Lab 2 Energia Introduction with Blink and the EduBP 

http://www.energia.nu/edumkii


Lab 3 Wi-Fi IoT with Temboo and Twitter 

We will break here to get to the heart of the lab portion! 

• Step 1: Navigate to the lab details or refer to handout 

• Step 2: Create an account on www.temboo.com  

• Step 3: Follow the lab details, no rude twitter shenanigans please 

• Step 4: Raise your hand if you need assistance 

Lab: https://goo.gl/VbymuW 
SSID: TEXINS3 

PASS: launchpad 
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Wi-Fi Connection for your LaunchPad, 

not your laptop, thanks! 

http://www.temboo.com/


Lab 4 More Wi-Fi IoT with Temboo 

We will break here to get to the bonus lab portion! 

• Step 1: Navigate to the lab details or refer to handout 

• Step 2: Follow the lab details 

• Step 3: Raise your hand if you need assistance 

 

Lab: https://goo.gl/VbymuW 
SSID: TEXINS3 

PASS: launchpad 
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Wi-Fi Connection for your LaunchPad, 

not your laptop, thanks! 



Thank you! 
 

www.ti.com/launchpad 
 
 


